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1.1 Login Properties 

 User Name – The name of the Login. 

Your Sage 500 logon credentials will be required if it differs from Windows authentication. 

 Password – If windows authentication is not being used, a Sage 500 password will be required. 

 Company – The company name is required. 

 Change Server / Database – This is used to login to a different SQL database or server. 

 
  

1.0 Getting started  
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1.2 Standard Reports Available 

Sage 500 Intelligence comes with sample reports that you can use as templates when creating your 
own reports. 

 

 

NOTE: Before you rely on them, you should test the reports to verify that they work with 
your company data. 

 

1.2.1 Financial Report 

This report displays balances per General Ledger Account number per financial period for the current 
financial year, previous financial year and current budget year. Income Statement and Balance Sheet 
layouts are automatically generated, grouped and sub‐totalled by mapped financial categories. All 
layouts can be fully customized using native Excel. Includes a predefined drill down report which allows 
you to drill dynamically to detailed ledger transactions. 

 
  



 

Sage 500 ERP Intelligence Reporting 5 

1.2.2 Financial Trend Analysis 

 

 

1.2.3 Dashboard Analysis 

Summarized display of Company Financials, Top Customers, Top SalesPersons, Top and Bottom 
Products and Sales over various periods.  

Graphs are included. 
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1.2.4 Income Statement 

 

 

1.2.5 Balance Sheet 
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1.2.6 General Ledger Transaction Details 
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1.2.7 Sales Master 

 

 

1.2.8 Inventory Master 
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1.2.9 Purchase Order Master 
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2.1 Accessing the Sage 500 Intelligence Reports 

 

To access the reports: 

1. From the Sage 500 Desktop, click on 500 Intelligence in the Tasks section. 

2. Click on Report Manager or Report Viewer. 

 

 

2.2 Running a Report 

1. Select the report you want to run. For this example, choose Sales Master under Sales. 

 

 

2. To run the report, click on the green Run icon. You can also right-click and select Run, or press 
Ctrl+R. 

2.0 Managing your reports 
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3. Enter Report Parameter. (Date/ Month) 

4. Click OK. 

5. The progress status is displayed on the right of your screen and indicates the process of your report. 
Depending on the size of your company data, running a report may take some time. You can 
sometimes cancel the report. 

 

 

6. Once the process has finished, the report opens in a new Microsoft Excel Workbook. 
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2.3 Copying, Pasting and Renaming Reports 

You can copy and paste a report, at any stage, in the report manager. These functions are useful in 
Sage 500 Intelligence because all the Master reports are locked and you need to make a copy of these 
master reports. Use the copy, paste, and renaming methods so you can create new reports from an 
existing report and therefore not corrupt the master report. 

You may have a sales report that shows a customer analysis on sales; however, you want to create 
another report that shows sales analyzed by Reps. You can create a copy of the original report, and 
then rename the copy to Sales by Rep, and then customize the new Sales by Rep report. You have the 
benefit of re‐using all the containers and expressions in the original report without having to create them 
from scratch. 

 

To create a new report from an existing report: 

1. Open the Report Manager from the Sage 500 Intelligence menu under Reports. 

2. Right-click on the report you want to make a copy of; e.g. Sales Analysis. 

3. Select copy to copy that report to the clipboard. 

 

 

4. Now paste the copied report onto a folder. 

5. Select a folder. You can choose the same folder that contains the original report or a different folder. 

6. Right-click on the selected folder and select Paste. 

7. Rename the newly copied report. By default, the report’s name is Copy of <report name>. 

Note – You can use the short-cut keys of Ctrl+C to copy the report, and Ctrl+V to paste instead of using 
the menus. 
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8. Right-click on the report and select Rename to give the report a different name. You now have an exact 
duplicate of the original report that will obtain its data from the same place, and deliver it in the same 
format, until you make any changes to this new report. 

 

2.4 Creating and Linking a Report 

It is entirely possible to customize the look and layout of the Sage 500 Intelligence Standard Reports. 

Although these reports are designed to encompass the needs of most business organizations, you may 
want to change the appearance (colors, text style, etc.) to reflect your company image, and perhaps 
change the order or inclusion of columns to suit your company processes. These changes can be 
saved for the next time you run the report. 

Creating Excel templates enables the user to create a template from an open Excel workbook and link it 
to an existing report so as to standardize the output format of the chosen report for every run instance 
in future. 

 

 

NOTE: If you are unsure of making changes to any of the Standard Reports, you should 
create a copy of the report before you make any changes. 

 

Sage 500 Intelligence users must make a copy of a report in order to edit the standard reports. 

2.4.1 To copy a report 

1. Open the Sage 500 Intelligence Report Manager. 

2. Right-click the report you want to copy and select Copy. 

3. Right-click on the report folder in which you want to paste the copy and select Paste. The copy of the 
report is renamed as Copy of < original report name>. 

 

2.4.2 To create and link the Report 

1. Open the Sage 500 Intelligence Report Manager. 

2. Select and run the report you want to cutomize; e.g. copy of Sales Master. 
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3. Make the changes to the report; ensure that Sheet1 (where Sage 500 Intelligence puts the Raw Data) 
and Sheet2 (where Sage 500 Intelligence puts the report parameters) are unchanged. 

 

 

4. After completing the changes, leave the workbook open and go back to the Report Manager. 

5. Right-click on the report for which the changes were made and select Create and Link Template. 
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6. Select the workbook with the changes in the window that appears. 

7. Click OK. 

 

 

8. When prompted with the following message, click Yes to link the workbook.  
Clicking No will not link the workbook. 

 

 

9. When prompted to specify the template name, change the name of the template. Doing so ensures that 
the original template is not overwritten with the copy. 

 

 

10. Click OK. 

11. Once the template has been successfully linked, a message is displayed. 
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2.5 Create a new report 

This process consists of two steps: 

 Add a folder 

 Add a report 

 

2.5.1 To add a folder 

1. Open the Sage 500 Intelligence Report Manager. 

2. Select Home. 

3. Right-click and select Add Folder. 

 

 

4. The Enter a Name for the Folder window opens: 

5. Enter a name for your folder; e.g., Sales Test. 

6. Click OK. 

 

2.5.2 To add a report 

1. Select the folder where you want to add the report; e.g., Sales Test. 

2. Right-click and select Add Report. 

3. Select the type of report to add when prompted. You will add a standard report. 

 

 

4. Enter a new name for the report; e.g., Sales Report. 
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5. Click OK and the Select Data Container window opens. 

 

 

6. Select the data container from which you want to source your data; e.g., Sales Analysis.  

7. The Choose Column Fields window opens. 

 

 

8. Select the columns you require in your report. 

9. (Optional) Click Select All to select all of the Expressions. 

10. Click OK.  

Your new report is now in your specified folder.  
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Sage 500 Intelligence Report Properties 

The report type (Standard, Dataless, Sub query or Union) mainly determines which standard tabs are 
available on the selected Properties window. A typical Properties window of Standard report types has, 
besides the Properties tab also a tab for each report output property, namely Columns, Filters, Parameters, 
Sort Fields, and Aggregate Filters. 

 

3.1 Report Properties Overview 

We will look at the properties and columns of a standard report. 

When selecting a report, tabs appear on the right of the screen. These tabs allow you to modify the 
report’s display output. 

 

3.1.1 Properties Tab 

The Properties tab enables you to view and change general report details such as the report name and 
description. To confirm any change select the Apply button on the top right of the properties window. 

 

3.0 Defining report properties 
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3.1.2 Columns Tab 

The columns window lists the columns that make up the Excel report. You are able to add, remove or 
change the order of the columns using the buttons on the top right of the window. 

 

 

3.2 Adding Additional Columns 

1. Select the Columns tab from the Properties window. 

2. Click Add. 

3. Select the desired column; e.g. Document number. 

 

 

4. Click OK. 

5. The new column appears in the Columns window. 
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3.3 Moving and Deleting Columns 

 

3.3.1 Moving Columns 

1. If you want the columns to appear in a certain order in Microsoft® Excel®, you can change their order in 
the Properties window. 

2. From the Properties window, select the Columns tab. 

3. Select the desired column/s. 

4. Click Move Up or Move Down. 

 

OR 

1. Select the desired column/s. 

2. Drag to the appropriate position. 

 

3.3.2 Deleting Columns 

1. From the Properties window, right-click on the desired column. 

2. Click Delete. 
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Four key reasons for organizing data into a PivotTable are: 

 To summarize the data contained in a lengthy list into a compact format. 

 To find relationships within the data that is otherwise difficult to see because of the amount of detail. 

 To organize the data into a format that’s easy to chart. 

 View the same data in many different ways quickly and easily. 

 

PivotTable reports use functions, allowing you to total, average and count data. These functions also provide 
subtotals and grand totals automatically, where you choose to show them. 

 

Original Worksheet 

 

 

PivotTable 

 

 
  

4.0 Creating a simple PivotTable 
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PivotChart 
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An important point to remember when working with PivotTables is that you are working within a layout slightly 
different to a normal Microsoft Excel worksheet. A PivotTable has its own Ribbon and that alone provides 
functionality specific to the PivotTable and not to a normal Microsoft Excel cell on the worksheet. 

Although one can format a cell using the format tools on the Home tab of the Ribbon, a PivotTable provides 
its own format cells option on its Ribbon as it is treated as a separate entity. 

 

A PivotTable has its own layout and is split up into 4 sections. 

 

 
  

5.0 PivotTable Concept and Layout – Excel 2007, 2010 
and 2013 
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Each of the above sections is used to show fields from the PivotTable source data, each section having 
its own purpose. 

Report Filter This section assists in providing a third dimension to your data. It can 
also provide a more summarised/filtered view of the rest of the fields 
displayed in the other sections. 
 
When placing a field in this section it therefore reduces the number of items 
within a PivotTable and in some instances prevents the PivotTables number 
of items limitation from being reached. 
 
If you include a page field in your PivotTable you can choose to display 
the PivotTable pages on separate worksheets.  Select the show pages 
button on the drop down menu of the PivotTable toolbar button.  
 
Microsoft Excel will automatically replicate each page’s data on a 
separate worksheet. 

Column Labels One would place fields in this section when wanting to group the data by a 
specific field e.g. by customer. Your customers will appear in the columns 
going across. 

Row Labels One would place fields in this section when wanting to group the data by a 
specific field. E.g. by Customer. Your customers will appear in the rows 
going down. 

Values One would normally place fields in this section where their values are 
numbers such as a qty or amount field e.g. Customer Sales. 
Calculations such as sum, average, min, max etc can be used on such 
fields. This section has to contain at least one field. 

 

 

5.1 Create a PivotTable Report 

To create a PivotTable you need to identify these two elements in your data: 

 Have a list in Microsoft Excel with data fields (headings) and rows of related data. 

 Identify which fields are going to go where in your design. 

 

1. Select any cell in the data list. 

2. From the Insert tab, in the Tables group, select PivotTable. 

 

 

3. Make sure that select a table or range is selected. When pivoting data from a source data sheet, 
where the data was rendered by Sage Intelligence, always use the named range Sheetname!RawData. 
This will ensure that the full range of data extracted is always available for use within the PivotTable. 
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When adding new columns to a report, these new columns of data will then automatically be included in 
the PivotTable range. 

 

 

4. Make sure your data is listed in the Table/Range box. 

5. Select where you want the PivotTable to go, either in an Existing Worksheet or New Worksheet. 

6. Select OK. 

7. A blank PivotTable will display. 

 

 

8. In the Field List select either the fields you want in the Row Labels or drag them into the Row Labels 
area on the Field List box. 

9. Repeat for Report Filter, Columns Labels and Values. 
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5.1.1 PivotTable Field List 

1. The PivotTable Field List contains the fields available for your PivotTable, based on the fields in the 
data range that the PivotTable is based on. In addition there are areas where you can add Report Filter 
(Page Area fields), sections that list the row and column fields and a section for the Data Area fields. 

 

 

Turn the Field List On/Off 

The PivotTable Field List is only visible while you are within the PivotTable.  

If you are within the PivotTable and it is still not visible, right-click and select Show Field List. You can 
also turn the field list on and off from the Ribbon. 

 

1. Select any cell in the PivotTable. 

2. From the Options tab, in the Show/Hide group, select Field List. 

OR 

1. Select any cell in the PivotTable. 

2. Right-click and select Show Field List. 
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5.1.2 Remove, add and move fields 

When selecting a field from the data area to move or remove, you need to select the field by placing the 
mouse pointer on the border of the field and clicking when the pointer changes to the normal arrow pointer. 

Fields that appear in the PivotTable will have a tick in their check box on the Field List. De‐selecting this 
check box will remove the field from the PivotTable. 

 

Remove a Field 

1. From the Field List select the check box next to the field you wish to remove. 

 

OR 

1. From the Field List, select the drop down arrow next to the field. 

2. Select Remove Field. 

  

Add a Field 

1. Select the check box next to the field in the Field List. 

 

OR 

1. Select the Field in the Field List and drag it to the desired area e.g. Report Filter. 
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Move Fields within the Table 

1. From the Field List, drag the field to the desired area. 

OR 

1. From the Field List, select the drop down arrow next to the field. 

2. Select Move Up, Move down etc. 
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An important point to remember when working with PivotTables is that you are working within a layout slightly 
different to a normal Excel worksheet. A PivotTable has its own toolbar and that alone provides functionality 
specific to the PivotTable and not to a normal Excel cell on the worksheet. 

Although one can format a cell using the format menu, a PivotTable provides its own format cells option on its 
toolbar as it is treated as a separate entity. 

A PivotTable has its own layout and is split up into 4 sections. With reference to the diagrams below you can 
see the layouts in two different ways. The one on the left being the layout which is visible on the Excel 
worksheet, the one on the right being the same layout but with its appearance when working within the 
PivotTable Wizard. 

 

 
 

Layout as per a PivotTable   Layout as per the 

displayed on a worksheet PivotTable wizard 

 
 

 

 
 
   

6.0 PivotTable concept and layout – Excel 2003 
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Each of the above sections is used to show fields from the PivotTable source data, each section having 
its own purpose. 

The Row Area One would place fields in this section when wanting to group the data by 
a specific field, e.g. by Customer. Your customers will appear in the rows 
going down. 

The Data Area One would normally place fields in this section where their values are 
numbers such as a qty or amount field e.g. Customer Sales. 
Calculations such as sum, average, min, max etc. can be used on such 
fields. This section has to contain at least one field. 

The Column Area One would place fields in this section when wanting to group the data by a 
specific field e.g. by customer. Your customers will appear in the columns 
going across. 

The Page Area This section assists in providing a third dimension to your data. It can 
also provide a more summarized/filtered view of the rest of the fields 
displayed in the other sections. When placing a field in this section it 
therefore reduces the number of items within a PivotTable and in some 
instances prevents the PivotTables number of items limitation from being 
reached. 

 

 

6.1 Create a PivotTable Report 

To create a PivotTable you need to identify these two elements in your data: 

 Have a list in Excel with data fields (headings) and rows of related data. 

 Identify which fields are going to go where in your design. 

 

1. Select any cell in the data list. 

2. On the Menu bar select Data. 

3. Select PivotTable and PivotChart Wizard. 

4. Make sure that Microsoft Excel list or database is selected as the data to analyze. 

When pivoting data from a source data sheet where the data was rendered by Sage Intelligence, 
always use the named range Sheetname!RawData. This will ensure that the full range of data 
extracted is always available for use within the PivotTable. When adding new columns to a report, 
these new columns of data will then automatically be included in the PivotTable range. 
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5. Make sure the kind of report is selected as PivotTable. 

 

 

6. Select Next. 

7. Select the collapse icon in the range box. 

 

 

8. Select the data range on the worksheet that contains the source data. 

9. The selected range will appear in the range box. 

 

 

10. Select the collapse icon again to return to your active worksheet. 

11. Select Next. 

12. On the next screen, select where you want to place the PivotTable, select New Worksheet. 
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13. Choose another cell if you do not want the current cell as the position on the worksheet. 

 

 

14. Select Layout. 

The PivotTable and PivotChart Wizard – Layout window displays: 

 

 

15. The column headings from the source data will now appear as fields on the right. 
  



 

Sage 500 ERP Intelligence Reporting 33 

16. Drag the fields to the relevant positions on the layout. 

 

 

17. Select OK. 

18. Select Options. 

19. Select your required options. 

20. Select OK. 

21. Select Finish. 

22. The PivotTable will now display. 

 

6.1.1 Remove, add and move fields 

When selecting a field from the data area to move or remove, you need to select the field by placing the 
mouse pointer on the border of the field and clicking when the pointer changes to the normal arrow 
pointer. 

 

Remove a Field 

1. Select a Field and drag it outside of the PivotTable area and drop it. 

OR 

1. Right-click on a Field. 

2. Select Hide. 

 

Add a Field 

1. Select a field from the Field List. 

OR 

1. Drag it into the PivotTable area and drop it in the appropriate position. 

2. On the PivotTable toolbar select PivotTable. 

3. On the PivotTable Wizard, select the Layout button. 

OR 

1. Drag the fields to the appropriate position. 

2. Select the field in the Field List. 

3. From the drop down, select the Area you would like to add it to. 
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Reports can be exported from one system and imported into another. The export function creates a 
compressed file with an .al_ extension which can be imported into other systems. The uncompressed version 
of the file will create a file with the extension .alx 

1. From the Object window, right-click on the desired report and select Export Report or select Export 
Report from the Tools menu. 

 

 

2. Select Export Report. 

3. Click OK. 

4. Select the Export folder when prompted. 

5. Click Save. 

6. You will get a message to confirm your Export Succeeded. 

 

 

7. Click OK. 

 

NOTE: If you are running a Third Party Developer License of Sage 500 Intelligence then it 
is possible for you to protect your export files. See Exporting Reports with Protection 
in the user's guide for more details. 

 

7.0 Exporting reports 
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Reports can be exported from one system and imported into another. The export function creates a 
compressed file with an .al_ extension which can be imported into other systems. The uncompressed version 
of the file will create a file with the extension .alx 

Report export files (.alx files) and compressed export files (.al_ files ‐ version 3.5 and later) created using the 
Export Report facility can be imported into Sage 500 Intelligence. Using this facility, Reports can be created in 
one Sage 500 Intelligence system and distributed to other Sage 500 Intelligence systems. 

1. Right-click on the Home object in the Object window. 

2. Select Import Report. 

 

 

3. Select the report to be imported (with the _al extension) and click Open. 

4. In the Import Report window, select the Target Connection (Administrator). 
  

8.0 Importing Reports 
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5. Then select the Report Destination (the folder). 

 

 

6. Click Import. 

 

 

7. Click OK. 

8. Double-click on the report folder to refresh. 
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Listed below is the information that is supplied to you for an import and a description of each element: 

 

 

 

 

Report Name The original name of the Report in the Source Sage 500 
Intelligence System. 

Created By Company The Company that created the Export File. 

Report Container The Source Container for the Report in the Source Sage. 

Source 500 Intelligence System. 

Creation Time The Date and time that the Export File was created. 

Original Template 

Name 

The name of the Report Template in the Source Sage 500 

Intelligence System. 

Template File Size The size (in bytes) of the Report Template File. 

Original Connection Name The name of the Source Data Connection in the Sage 500 

Intelligence Source System. 

Export Library 

Version 

The Version of the Export Program Library used to create the 
export file. 

Import Library Version The Version of the Import Program Library being used to perform 
the import. 

Target Connection The Connection that you have selected as the Source for the new 
report that will be created by the import. 

Target Connection Type The Source Connection Type of the Connection that you have 
selected as the Source for the new report that will be created by 
the import. 

Report Destination The Report Manager Folder into which the new report will be 
imported. 
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1. In the Sage 500 Intelligence menu, choose Security Manager. 

2. In the Security Manager window, make sure the Security On checkbox is checked. 

3. Enter a password and click Set.  

4. Click the Add button under the Roles section to add a new role. 

 

 

5. On the Reports tab, select the reports that the Role should be able to access. 

 

 

NOTE: Union/sub reports are automatically added when the main report is added. 

 

6. Then click the Users tab and select the users that should belong to this role. 

7. The user now has access to the reports that the system administrator has assigned to the role. 

 

 

 

 

9.0 Security Manager 


